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DYNAMIC RESPONSE APPROACH AND METHODOLOGY

Traditional seismic stability procedures 

vs 

coupled effective-stress approach.
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Traditional seismic stability procedures:

• Empirical and laboratory corrections and simplified 
procedure to evaluate the potential for liquefactions of 
embankment and foundation soils-SPT, CPT or Vs based 
methods.

• Limit equilibrium stability analyses to evaluate post-
earthquake stability.

• Newmark-type estimates of permanent deformation.
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What Traditional Seismic Stability Assessment Give 
you and Can’t Give you

• DO: 
• State-of-practice estimates of the potential for occurrence or non-

occurrence of liquefaction during and at the end of strong earthquake 
shaking.

• DON’T: 
• model the progressive changes in the soil’s state during earthquake 

shaking, 

• the potential for buildup of pore water pressure,

• The occurrence of liquefaction,

• The resulting permanent deformations during and after the earthquake
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Coupled Effective-Stress Analysis of 
this Webinar

• To estimate the performance of the embankment during and after 
earthquakes

• model the progressive changes in the soil’s state during earthquake shaking, 

• the pore water pressure build up,

• If liquefaction occurs or not,

• The resulting permanent deformations during and after the earthquake
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Problem Descriptions

• The pond is located along a river. Liquefaction screening results indicate 
that zones within the pond embankment are potentially susceptible to 
liquefaction based on the estimated seismicity for the design seismic 
event with a 2,475 year return period. The susceptible zones are 
composed of embankment fill at depths ranging from 15 to 30 feet 
below the ground surface.  

• Preliminary post-earthquake limit equilibrium slope stability analyses 
based on the results of the screening level liquefaction analysis suggest 
that the part of the pond Dam do not meet the required slope stability 
factors of safety. To bring more insight into the liquefaction potential of 
the site materials and seismic stability of the embankment, more 
sophisticated nonlinear dynamic analyses are performed herein under 
the design level earthquake shaking.  
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Representative Section From Slop Stability Analysis 
with Liquefiable Embankment Layer. 
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Relevant Soil Exploration Data
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Potentially Liquefiable Soil Layers based on (N1)60:
– a liquefiable layer in the weathered rock was added and the slope of the 
weathered rock was revised
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Steps of Coupled Effective-Stress Analysis

• Evaluation of initial static stresses

• Establishing phreatic surface using water table or through 
seepage analysis

• Switching nonlinear soil constitutive model to the 
liquefiable layers

• Obtaining earthquake input motion through site specific 
hazard analysis or building code

• Seismic runs and result processing
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This Webinar Does not cover details of 
following

• Static initial stress state was established from a 
construction stage and phreatic surface was input as a 
water table based prior anlysis.

• Three Earthquake records was obtained through a site 
specific hazard analysis but only one is used in this 
demonstration
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Focus on Liquefaction

• Liquefaction: Liquefaction occurs when effective stresses 
become or close to zero due to generation of excess 
pore water pressure. 

• For civil or geotechnical engineers, when we talk 
liquefaction, we mainly are talking about saturated 
cohesionless soil under short term loading such as 
earthquake when there is no time for the excess pore 
pressure to dissipate.     
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Consequences of liquefaction

• liquefied soil softens and loss its shear strength so 
potential large deformation could occur. 

• For embankment of impoundment, when large 
deformation occurs due to liquefaction, dam could fail 
or lose its functionality. 

• For structures, the foundation bearing capacity could be 
reduced to an extent to cause detrimental effects to the 
structure such as differential/large settlements, 
cracking, etc.
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Key for Modeling Liquefaction

• The single most important task in liquefaction modeling is to 
capture the excess pore pressure reasonably accurate by the 
chosen soil constitutive model. 

• Great effort has been spent in this area for many years by 
academia and engineers. The available models are UBCSand, URS 
Model, PM4Sand (UC Davis), WangCS (Amec Foster Wheeler) 
among others. 

• The first two are models modified from the Mohr-Coulomb model 
and the last two are models developed using bounding surface 
plasticity theory. UBCSand is the first and only one available for 
Midas users at this time.
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1. UBC Sand Model

▪ An effective stress model for predicting liquefaction behavior of sand under seismic loading.

▪ GTSNX Liquefaction Model is extended to a full 3D implementation of the modified UBCSAND model using implicit method.

`

▪ Nonlinear Elastic: 
- Exponential function per effective pressure

▪ Plasticity / Shear 
- Yield function : Mohr – Coulomb
- Flow rule : Menetrey-Willam (non-associated)
- Hardening behavior : Hyperbolic hardening

▪ Plasticity / Compression (cap) 
- Yield function : Modified Mohr-Coulomb Cap

- Flow rule : Same with yield function (Associated flow)
- Hardening behavior : Hardening of allowable compression per volumetric strain

▪ Plasticity / Pressure cut-off
- Yield function & Flow rule

- No Hardening behavior
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▪ Cyclic loading behavior

- Consider Shear, Plasticity function for primary and secondary yield surface 
respectively  Check difference of hardening behavior

- Primary yield surface: In case that the current stress ratio (or mobilized friction 
angle) reach to the critical (MAX) state of the material

- Secondary yield surface: In case that the current stress ratio is smaller than the 
critical (MAX) state of the material according to the unloading/reloading
conditions

- Secondary hardening (Soil Densification)
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Parameter Description Reference

Pref Reference Pressure
In-situ horizontal stress at mid-

level of soil layer

Elastic (Power Law)

Elastic shear modulus number Dimensionless

Elastic shear modulus exponent Dimensionless

Plastic / Shear

Peak Friction Angle Failure parameter as in MC model

Constant Volume Friction Angle -

C Cohesion Failure parameter as in MC model

Plastic shear modulus number Dimensionless

Plastic shear modulus exponent Dimensionless

Failure ratio (qf / qa)
0.7~0.98 (< 1), decreases with 

increasing relative density

Post Liquefaction Calibration Factor Residual shear modulus

Soil Densification Calibration Factor Cyclic Behavior

Advanced parameters

Pcut Plastic/Pressure Cutoff (Tensile Strength) -

Cap Bulk Modulus Number -

Plastic Cap Modulus Exponent -

OCR Over Consolidation Ratio
Normal stress / Pre-overburden 

pressure
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UBC Sand Model Parameters

▪ Additional parameters to simulate liquefaction

▪ Estimation of each parameter using Standard Penetration Test (SPT) - ((N1)60 : Equivalent SPT blow count for clean sand.
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Input 
Parameter
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Modified UBCSAND _ GTSNX
• Nonlinear Elastic

– Exponential function per 
effective pressure

• Plasticity/Shear

– Yield Function: Mohr-Coulomb

– Flow Rule: Menetrey-Willam
(non-associated)

– Hardening behavior : Hyperbolic 
Hardening
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• Plasticity/Compression (cap)

– Yield Function: Modified Mohr-Coulomb Cap 

– Flow Rule: Same with Yield Function (Associated flow)

– Hardening Behavior: Hardening of allowable compression 
per volumetric strain

• Plasticity/Pressure cut-off

– Yield Function & Flow Rule:

– No Hardening Behavior
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• Cyclic loading behavior
– Consider Shear, Plasticity function for primary and secondary yield surface 

respectively  Check difference of hardening behavior

– Primary yield surface: In case that the current stress ratio (or mobilized 
friction angle) reach to the critical (MAX) state of the material

– Secondary yield surface: In case that the current stress ratio is smaller than 
the critical (MAX) state of the material according to the unloading/reloading
conditions
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Model Calibration

• Lab test 
– Monotonic and cyclic 

drained Direct Simple 
Shear (DSS) test (skeleton 
response) 

– Constant volume DSS test 
(undrained test)

– Single element test (3D or 
2D), calibration
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Model Calibration – initial 
estimates

• Standard Penetration Test (SPT), Calibration (Beaty, Byrne)
– Clean sand equivalent SPT blow count measurement: (N1)60

 
0.333

1 60
21.7 20.0e

GK N  

0.0163 

 
2

1 60
0.003 100.0p e

G GK K N  

    

 
 

  

1 160 60

1 60

1 160 60

/10.0 15.0

15
/10.0 max 0.0, 15.0

5

cv

p

cv

N N

N
N N






 

  
    

 

 
0.15

1 60
1.1fR N


 

0 030 34cv 

0.5

0.4

ne

np







GTS NX 2017

Undrained DSS (Monotonic)
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Undrained DSS (Cyclic)
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`

UBC SAND _ Model Calibration_Summary
▪ Monotonic and cyclic drained Direct Simple Shear (DSS) test (skeleton response).

▪ Constant volume DSS test (undrained test)
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Bounding Surface Plasticity Wang Model
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Wang Critical State Model
Wang captures most of cohesionless soil behaviors under complex loading such as cyclic. Two simple observations 
(the UBCSand-Slide 14 can’t capture): pore pressure build-up during unloading phase; and dilation when loading 

beyond the phase transformation line. 
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More Model comparisons with Dynamic Simple Shear 
(J. Wu and R. Seed, 2003)
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Continue
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Wang Model Parameters

Type Dr (%) φ' degree Go hr kr d Poisson ratio gamma ita Rp/Rf Void ratio e1

1 45 28 181 0.15 0.2 4 0.33 15 7 0.50 0.69

2 60 28 242 0.15 0.2 6 0.33 15 20 0.50 0.73

Table 1 Model Parameters of Sand (Dr=45% or 60%)

Notes: 

(1) Void ratio e=0.541 + Dr*0.314 where assuming emax=0.855 and emin=0.541
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Continue – Wang model parameters
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Continue - Model Parameters hr calibrated from 
G/Gmax and damping curves
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Continue – Model Parameter Go that defined the Initial 
(maximum) Elastic Modulus 
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Continue – last 2 Model Parameters gamma and ita, which control the post-liquefaction strain 
accumulations, i.e. stress path stabilized (left figure) but strain continue accumulating (right figure)
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Pre-Existing Shear Stress, kα effect
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UBC Sand Post Processing – Liquefiable Area or Pore Pressure Ratio or Ru

▪ Specific results which can check the liquefiable area directly

▪ Two types of results are available to measure the possibility of liquefaction.

▪ Pore Pressure Ratio (PPR)
- The ratio of excessive pore pressure change and the initial effective pressure

' '

' '

w init current

init init

p p p
PPR

p p

 
  

Excessive Pore Pressure Change

Initial Effective Pressure

Current Effective Pressure

wp
'

initp
'

currentp

▪ Normalized Max Stress Ratio
- The ratio of mobilized friction angle and the peak friction angle
- When the Max stress ratio is reached, the mobilized friction angle is close to the 

peak friction angle, liquefaction is triggered (1 = Liquefaction)

sin
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UBC SAND Layer
Mohr Coulomb Layer

[Nonlinear Time History Analysis under the earthquake]
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UBC Sand Normalized Max Stress Ratio

[Nonlinear Time History Analysis under the cyclic loading]

▪ Normalized Max Stress Ratio
- When the Max possible stress ratio is reached, liquefaction is triggered and

is reduced as

- , where facpos is a user defined Post Liquefaction Calibration Factor

m

p

[T = 0.01 sec]

[T = 0.06 sec]

[T = 0.15 sec]

[T = 0.5 sec]

UBC SAND Layer
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Analysis options
(Large deformation, 

Excessive Pore Water Pressure,
Post-Processing) 
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1) Damper (Mesh > Element > Create > Other > Ground Surface Spring)

• The viscous boundary element required as a model boundary condition for 

time history analysis. 
• The viscous boundary element can be created from the following steps. 

1. Compute Cp, Cs : Cp, Cs can be calculated using the equation below. 

λ : Bulk modulus, G : Shear modulus, E : Elastic modulus, ν : Poisson’s ratio, A : Cross-section area 

2. The cross-section area is automatically considered until the surface spring is 

created, so only the Cp, Cs needs to be computed. When creating the viscous 

boundary element automatically, the spring is automatically created by considering the 

element area (effective length*unit width) as shown below. Input the Cp value for the 

normal direction coefficient at the point of spring creation and input the Cs value for the 

parallel direction. 

1) Damper
2) Free Field (Infinite boundary, Absorbent boundary)

1. Boundary Conditions for the damping effect 
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2) Free Field (Mesh > Element > Free Field)

For the seismic analysis, users need to model infinite ground to eliminate the boundary effect 

caused by reflection wave. Since it is not possible to model infinite ground, users can apply 

Free Field Element at the boundary.

Absorbent Boundary : Enable to eliminate reflection wave at the ground boundary
Width Factor (Penalty Parameter) : In order to minimize the size effect of the model, 
users have to input more than 104, This value will be multiplied by model width (In case 
of 2D, this is plain strain thickness (unit width).

1) Damper
2) Free Field (Infinite boundary, Absorbent boundary)

1. Boundary Conditions for the damping effect 
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1) Ground Acceleration (Dynamic Analysis > Load > Ground Acceleration)



GTS NX 2017 2. Dynamic Load

2) Analysis Time : Define Time Step for the analysis and the output
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1) Undrained Condition : Allow Undrained Material Behavior to check the generated 
excessive pore water pressure under short term loading like earthquake

- Material > Porous > Drainage Parameters

- Analysis Control > Undrained Condition (for each analysis case or for each 

stage)
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2) Geometry Nonlinearlity

- Consider Geometric Nonlinear Effects to simulate large deformation
(Analysis Case > Analysis Control > Nonlinear)
- Analysis can take into account load nonlinearity which is reflecting the effects of follower loads, where the 

load direction changes with the deformation. Depending on the deformed shape, the pore water pressure 
can be updated automatically.
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3) Element Formulation (Analysis > Tools > Options > Analysis/Results > Element 
Formulation)

- Hybrid (Default setting)
- Standard (for large deformation, geometric nonlinear option)



GTS NX 2017 4. Output Options

1) History Output Probes 
(Analysis > History > History Output Probes & Result > Special Post > 
History > Graph)
- Output option which can check the result with time at the specified node or element 
such as total or relative displacement and the excessive pore water pressure with time
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Case Study
(Tailings Pond Embankment Seismic 
Stability – Excess Pore Pressure and 
Permanent Displacement using FLAC 

and GTSNX) 
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1. The FLAC Model. 
One of the difficulty of using 

FLAC is the creating of the most appropriate grid for 
the problem such as more zone density at the 

highly deformed location of the liquefiable layer.
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Constitutive Models in FLAC

• FLAC built in – Finn model

• User defined dlls: UBCSand, Wang model, PM4Sand 
among others.

• The one used for this project: Wang bounding surface 
plasticity model
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Wang Model Parameters: Most of them have clear physical meaning 
and can be calibrated from routine lab and/or field tests

Material Description
Friction Angle

G0 hr d kr fp bc ein Poisson

φ (deg)

Potentially Liquefiable (i.e., 
Saturated) Embankment

Fill
31 380 0.25 2.5 0.5 0.75 2 0.65 0.4

Potentially Liquefiable 
Foundation Soils (Alluvium)

34 150 0.08 1.2 0.5 0.75 2 0.78 0.4

Table 3 Material Properties for the nonlinear bounding surface plasticity models (1)
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Input Earthquake Record: 
PGA=0.055g. Three earthquake records were obtained from a site specific hazard analysis 
but for this presentation only the short duration record is used.
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Dam Crest Displacement Histories
Negative sign for the horizontal direction indicates toward the downstream side; and
negative sign for the vertical direction indicates settlement.
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Mean Effective Confining Pressure P Histories: P reduced some but not close to liquefaction 
when P should be close to zero (0).
Left figure is for a zone near the downstream toe in the liquefiable foundation layer; and right figure is for a zone in the liquefiable 
embankment about 30 ft horizontally from the Upstream crest edge and 20 ft below the crest.  
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Dam Crest Horizontal Acceleration: 
the input acceleration (slide 32) was amplified more than two times 
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Result Summary

• Dam embankment experience some shake but with very limit 
permanent displacements

• Some excess pore pressure generated in the liquefiable foundation 
and embankment layers but not enough to cause liquefaction

• This result seems reasonable as the input motion has a pga of 0.055g 
only


